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Annexes 

1. Annex 1: Inclusive learning design in social media 

1.1. Why inclusive learning for social media? 

Social media are very important in e-learning and inclusive design increases access. A social 
media strategy that considers inclusive design does the same. Without accessibility, we will 
miss out on connecting with our full potential audience. 

A 2018 survey of Facebook users in 50 countries found that more than 30% of people report 
difficulty with at least one of the following: seeing, hearing, speaking, organizing thoughts, 
walking, or grasping with their hands. 

Keeping social media accessible means recognizing exclusion, learning from our followers, 
and presenting information in the clearest ways possible. Plus, just about everyone likes to 
see inclusivity in advertising. According to a recent survey by Google, 64% of people took an 
action after watching an ad they considered inclusive. 

1.2. Inclusive design tips for using social media main learning 

 Make text accessible 

Writing with clarity makes the text more accessible and understandable. Before we hit 
publish, consider how assistive tools like screen readers will read our copy.  

Here are some inclusive design tips for text: 

• Write in plain language. Avoid jargon, slang, or technical terms unless they are 
appropriate. 

• Do not overuse caps. Full-caps can be difficult to read and misinterpreted by screen 
readers. 

• Limit emoji use. Emoji and emoticons (i.e. ̄ \_(ツ)_/¯ ) are read aloud by assistive tech. 
That means people will hear things like “loILDy crying face” or “pile of poo.” Before 
using one, look up how it translates to text. 

• Use an adequate font size. Make sure text is legible, especially when used in images 
or areas that aren’t modifiable. 

• Avoid special characters. In addition to reduced legibility, VoiceOver and other 
assistive tools read special formatting very differently. 

• Limit line length. Lines that are too long can interfere with readability and retention. 

• Use inclusive language. Avoid ableist language, stick with gender-neutral pronouns 
and terms, share diverse voices and emojis, and evaluate text for assumptions of 
limited points of view. 

Provide descriptive image captions 

Descriptive captions and alternative text (also known as alt text) allow people to visualise 
images when they cannot see them. According to WebAIM, a nonprofit with the Centre for 
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Persons with Disabilities, missing or ineffective alt text is the most problematic aspect of web 
accessibility. 

Several social media platforms use object recognition technology to provide automatic 
alternative text. In this circumstance, there are limits to its reliability. It’s always better to add 
a custom description when we can. 

Facebook, Twitter, Instagram, and LinkedIn provide specific fields for us to add alt-text for 
images and GIFs. When it’s not possible to add alt-text, we can include descriptive captions. 

Tips for writing descriptive alt-text: 

• Convey the content: There’s a huge gap between “Image of a chart” and something 
like, “A bar chart illustrates that there has been a year-over-year increase in forest 
fires, peaking at 100 this year.” 

• Skip saying “image of” or “photograph of” The Royal National Institute of Blind 
People says most screen readers prefer we do not. 

• Mention colour if it is important to understand the image. 

• Share humour. Descriptive text does not have to be overly formal and should do its 
best to express what is funny. 

• Transcribe text. If the image has a copy that is central to its meaning, we should 
include it in the description. 

• Do not forget GIFs. Twitter recently made alt-text an option for GIFs. If the platform 
does not support alt-text, include a description in the action. 

Include video captions 

Closed captions are crucial for viewers with hearing impairments. They also enhance the 
viewing experience for people watching in their non-native language or viewers in sound-off 
environments. Captions even benefit children learning to read. 

Internal tests at Facebook found that video ads that include captions see a 12% increase in 
view time on average. Captions help with recall, too. Multiple studies have shown that people 
who watch videos with captions are more likely to remember the content. 

• Facebook: Auto-generate captions, we write them ourselves, or upload a SubRip (.srt) 
file. Automatic closed captioning is also available for Facebook Live and Workplace 
Live. 

• YouTube: Auto-generate captions, transcribe them, or upload a supported file. Errors 
can be corrected with the caption editor. Automatic captions are available in English 
for YouTube Live. Community captions, which allowed accounts to crowdsource 
captions and translations, has been discontinued. 

• Instagram: Automatic closed captioning is now available for IGTV Live and IGTV. 
Otherwise, video captions must be burned in or encoded in advance. Add captions to 
our Instagram Stories, and TikTok and Snapchat videos, with custom text. 

https://www.facebook.com/help/214124458607871?helpref=search&sr=2&query=alt%20text
https://help.twitter.com/en/using-twitter/picture-descriptions
https://help.instagram.com/503708446705527
https://www.linkedin.com/help/linkedin/answer/109799/adding-alternative-text-to-images-for-accessibility?lang=en
https://twitter.com/TwitterA11y/status/1235671304050634754
https://www.facebook.com/help/509746615868430
https://support.google.com/youtube/answer/2734796?hl=en
https://support.google.com/youtube/answer/2734698
https://support.google.com/youtube/answer/2734705?hl=en
https://support.google.com/youtube/answer/6373554?hl=en
https://support.google.com/youtube/answer/6052538?hl=en
https://help.instagram.com/225190788256708?helpref=faq_content


 

 

 
 

 
Copyright © by DEMO OR DIE All Right Reserved | Guideline for inclusive teaching for instructors and inclusive 

learning for students. Annexes 
viii 

 

• Twitter: Upload an .srt file with our video. Twitter is also working to add automated 
captions to video and audio. 

• LinkedIn: Upload an .srt file with our video. 

When alt-text fields are not available, we must include a description in our caption.  

Add video descriptions 

Unlike captions, which are usually a transcript of spoken dialogue, descriptive language 
denotes the important sights and sounds that are not spoken. There are a few ways to provide 
descriptions: 

• Descriptive audio. Described video is the narrated description of any important non-
verbal elements in our video. This track is written and recorded to fit within the gaps 
between important audio elements. On social media, described video is typically 
“baked in” and cannot be turned off. 

• Descriptive transcript. Sometimes referred to as a media alternative transcript, these 
transcripts provide descriptions alongside dialogue, much like a script. 

• Live described video. Live video hosts should be familiar with descriptive video 
techniques, taking pauses to describe what’s happening on screen. Accessible Media 

Inc. has a good best practices guide. 

Use a colour contrast of at least 4.5:1 

For people who are colour-blind or those who have switched to grayscale to ward off the 
dopamine delivered by red notifications, colour contrast is important. 

The ideal contrast between the text colour and its background should be at least 4.5 to 1, as 
recommended by WCAG. For larger text that ratio decreases, but it increases for smaller text. 
The variations may seem subtle, but they make a big difference for different viewers. 

• Avoid green and red or blue and yellow combinations, as they’re difficult to read. 

• Text can be difficult to read on images, so consider using a solid background or opaque 
overlay. 

• On graphs and charts, consider also using patterns to differentiate data. 

  

https://media.twitter.com/en_us/articles/blogs/2019/subtitles-now-available-in-ios-and-android.html
https://www.linkedin.com/help/linkedin/answer/93997/add-closed-captions-to-videos-on-linkedin?lang=en
https://nbviewer.jupyter.org/github/a11yofficer/dvbp/blob/master/Live_Described_Video_Best%20Practices.pdf
http://www.w3.org/TR/UNDERSTANDING-WCAG20/visual-audio-contrast-contrast.html
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Figure 1: Do and do not in Facebook example 

Do not rely on colour to convey meaning 

At least 2.2 billion people globally have some form of vision impairment, including colour-
blindness, low vision, near vision and blindness. In fact, Facebook’s colour scheme is blue 
because its founder, Mark Zuckerberg, is red-green colour-blind. 

Colour can also mean different things for different cultures. For instance, red may signify a 
downward trend on US financial charts, but in China red is positive. 

• Visualize links. We add an underline or a hover animation to convey that hyperlinked 
text is clickable. 

• Use symbols. In graphs or infographics, we use symbols or patterns as an alternative 
or addition to colour. Or, add clarifying labels. 

Stay informed about accessibility tools 

Some platforms run official accounts devoted to accessibility.  

Facebook: 

• Facebook Accessibility Page 
• Facebook Accessibility on Twitter 
• Facebook’s Navigation Assistant 
• Facebook Accessibility Help Centre 
• Submit Facebook Accessibility and Assistive Technology feedback 

Twitter: 

• Twitter Accessibility account 
• Twitter Able account 
• Twitter Together account 

https://www.facebook.com/accessibility
http://twitter.com/fbaccess
https://www.facebook.com/help/android-app/586155171554691?helpref=uf_permalink
http://www.facebook.com/help/accessibility
https://www.facebook.com/help/contact/?id=169372943117927
https://twitter.com/TwitterA11y
https://twitter.com/TwitterAble
https://twitter.com/TwitterTogether
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• Twitter Safety account 
• Share feedback on accessibility and other issues 

YouTube: 

• YouTube accessibility settings 
• Using YouTube with a screen reader 
• YouTube support 

Pinterest: 

• Emotional Health Resources 
• Pinterest Help Centre 

LinkedIn: 

• LinkedIn Disability Answer Desk 

1.3. Social media accessibility tools 

• WAVE Browser extensions: The Web Accessibility Evaluation extensions can be used on 
Chrome and Firefox to assess our website and its content for accessibility. 

• Hemmingway Editor: we can ensure the readability of our copy with Hemmingway 
Editor. Aim for Grade 8 and lower to comply with WCAG standards. The Readability Test 
Tool is another option. 

• Microsoft Accessibility Checker: Microsoft has a built-in accessibility tool available in 
Outlook, Excel, and Word. Microsoft Inclusive Design Manual also offers videos and 
downloadable booklets on inclusive design topics. 

• Thread Reader App: This Twitter bot unrolls threads on the platform so that people can 
read them more easily. To prompt the app, simply tag it and write “unroll” in reply to 
the thread in question. 

• Image Alt Text and Alt Text Reader: Tag @ImageAltText or @Get_AltText in reply to a 
tweet with an image to trigger these Twitter bots. If available, they’ll respond with the 
alt text. 

• Cliptomatic: we can add captions automatically to our Instagram Stories, TikTok videos 
and Snaps with Cliptomatic. 

• Contrast App: If we use a Mac, Contrast app is a WCAG-compliant contrast checker. A 
nice feature of this app is that it allows designers to check their contrast scores as they 
select colours. The creators of this app even provide a guide that simplifies WCAG 
standards. 

• Contrast Checker: Contrast Checker lets us drag and drop a specific image for a contrast 
check, which is a good thing to do before uploading assets to social media. 

• Colour Oracle: To ensure that we aren’t using colour alone to relay information, use the 
free colour blindness simulator. The open-source tool is available for Windows, Mac, 
and Linux. 

https://twitter.com/TwitterSafety
https://help.twitter.com/en
https://support.google.com/youtube/topic/9257112?hl=en&ref_topic=9257107
https://support.google.com/youtube/answer/189278?hl=en
https://support.google.com/youtube#topic=9257498
https://newsroom.pinterest.com/en/post/new-tools-for-managing-difficult-emotions
https://help.pinterest.com/en
https://www.linkedin.com/accessibility
http://www.hemingwayapp.com/
http://www.hemingwayapp.com/
https://www.webfx.com/tools/read-able/
https://www.webfx.com/tools/read-able/
https://support.microsoft.com/en-us/office/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f?ui=en-us&rs=en-us&ad=us
https://www.microsoft.com/design/inclusive/
https://twitter.com/threadreaderapp
https://twitter.com/ImageAltText/with_replies
https://twitter.com/get_altText/with_replies
https://www.apalon.com/clipomatic.html
https://usecontrast.com/
https://usecontrast.com/guide
https://contrastchecker.com/
http://colororacle.org/
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• Colour Safe: Use Colour Safe if we need help finding a colour palette that offers enough 
contrast and adheres to WCAG Guidelines. 

• Text on background image a11y check: This text-over-image accessibility tool helps us 
determine how legible text is based on colour contrast. Using Facebook’s Image Text 
Check tool we can determine if we have too much text on our image. 

• YouDescribe: YouDescribe, by the Smith-Kettlewell Eye Research Institute allows 
volunteers to create descriptive audio for YouTube videos. Simply copy and paste a 
YouTube url into the search field and click Create/Edit Descriptions to get started. 

• 67 Percent Collection: As a part of its #SeeThe67 percent campaign, Refinery29 teamed 
up with Getty Images to offer images featuring plus-sized women. See also the No 
Apologies Collection, a continuation of the collaboration. Dove also partnered with 
Getty to break down beauty stereotypes with the Show Us collection. 

• The Gender Spectrum Collection: Vice encourages media to go “beyond the binary” 
with this stock photo collection. 

• The Disability Collection: Global Accessibility Awareness Day, Getty Images, Verizon 
Media, and the National Disability Leadership Alliance (NDLA) team up to repicture 
disability with this catalogue. The Brewers Collective also created catalogues with 
Unsplash and Pexels. 

• The Disrupt Aging Collection: Access more than 1,400 images that combat ageist biases 
in this collection created by AARP and Getty. 

• Aegisub: Aegisub is a free open-source tool for creating and editing subtitles. We can 
also use this tool to create transcripts for videos. 

• Mentionolytics: we ca track our brand mentions across social media and the web with 
Mentionolytics. This tool is a good way to show up and respond to questions and 
feedback, whether we’ve been @-mentioned or not. 

• Web Content Accessibility Guidelines (WCAG) 2.1: These recommendations set the 
industry standards for accessible web and social media experiences. 

• Vox Product Accessibility Guidelines: These guidelines provide an interactive checklist 
for designers, editors, engineers and more. 

  

http://colorsafe.co/
http://www.brandwood.com/a11y/
https://www.facebook.com/ads/tools/text_overlay
https://www.facebook.com/ads/tools/text_overlay
https://youdescribe.org/
https://www.gettyimages.ca/photos/67percentcollection?mediatype=photography&phrase=67percentcollection&sort=mostpopular
https://www.gettyimages.ca/photos/noapologiescollection?family=creative&license=rf&phrase=noapologiescollection&sort=best#license
https://www.gettyimages.ca/photos/noapologiescollection?family=creative&license=rf&phrase=noapologiescollection&sort=best#license
https://www.gettyimages.ca/photos/showus?excludenudity=false&family=creative&license=rf&phrase=showus&sort=best#license
https://genderphotos.vice.com/
https://www.verizonmedia.com/accessibility/disability-collection?guccounter=1
https://www.verizonmedia.com/accessibility/disability-collection?guccounter=1
https://unsplash.com/@elevatebeer
https://www.pexels.com/@elevate/
https://www.gettyimages.ca/collections/disruptaging
http://www.aegisub.org/
https://apps.hootsuite.com/apps/mentionlytics
https://www.w3.org/TR/WCAG21/
http://accessibility.voxmedia.com/
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2. Annex 2: Creating accessible documents 

2.1. Creating accessible Word documents 

Microsoft Word is currently the most common word processor we use to produce course 
materials. When creating Word Documents, it is important to follow certain steps to make 
the files accessible with simple navigation, consistent layout, and a better user experience. 

We recommend that make the documents accessible when you initially create them to avoid 
later frustrations as we try to retrofit our content. Spending the extra time on the front-end 
of developing the content will save us a lot of time that would be spent fixing inaccessible 
materials. Additionally, making the Word Document accessible will generally produce an 
accessible Adobe PDF when we export it as that file type. 

2.1.1. Heading Styles 

Headings organize the content of a page in a hierarchical structure. Use headings to make 
fonts larger instead of changing the font size if the text is supposed to indicate a section of 
content. Headings should always be descriptive of the section to which it pertains. Section 
headings allow for a quick scan of the content for sighted and non-sighted users. People using 
screen readers are also able to search using their assistive technologies (ATs), making their 
learning experience much more efficient. 

We can create a uniform heading structure on the Styles menu in Word. To do this: 

1. Start a new line to create a heading or select text to change to a heading. 
2. Open the Home tab, and choose the appropriate heading in the Styles panel. 
3. Headings 1, 2, or 3 can also be assigned using Ctrl + Alt + 1, 2, or 3, respectively. 

 

Figure 2: Heading structure 

Below is an example of headings used to structure sections. 
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2.1.2. Alt Text 

Alternative text (alt text) describes the information or function represented by images and is 
provided through the use of an 'alt' attribute associated with the image element or within the 
context of the image. Keep in mind that when we add alt text, we won't see it, but screen 
readers will! 

Alt attributes should succinctly describe the content conveyed by the element, without being 
too verbose (for simple objects) or too vague (for detailed objects).  

2.1.3. Classifying images 

When adding alt text, it is important to consider the function of an image. Depending on the 
purpose of the image, our image can be classified as: 

• Decorative 

• Example 

• Supplemental 

These classifications will guide us in creating meaningful, accurate alt text. We must ask 
ourselves the following questions to determine what type of alt text should be added: 

• Is the image added to make the content more visually appealing? Does it enhance 
aesthetic? Can the image be removed without degrading the quality of the learning 
material? 

If we answered yes to these questions, and our image does reinterpret or add information, 

our image is decorative, and should include alt text that says "null" or "decorative image". 
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• Is the information contained in the image repeated in the text? Is it used as an example 
of the information that is already presented in the text? 

If we answered yes to these questions, and the image does not contain any information not 

available in the body of the text, our image is an example image and should include alt text 

that gives an overview description of what is seen in the image. 

• Does the image visually demonstrate what is in the text, and provide some additional 
information? 

If we answered yes to this question, and no to the previous questions, our image is a 

supplemental image. Since screen readers and other ATs cannot read text that's embedded 

on an image, it requires long descriptive text for the alt text. Additionally, the long description 

should be a part of the text content, so all students can review the information. It might be 

beneficial to reconsider the presentation of the information in the image and add the 

information from the image to the text content of the Word Document instead. 

2.1.4. Tips 

When we are writing alt text, we must keep in mind that it should succinctly describe the 

content conveyed by the element, without being too verbose (for simple objects) or too vague 

(for detailed objects).   

Some best practices for alt attributes are: 

• Be accurate 

• Be succinct when describing the content and function, if applicable, of the image 

• Avoid the use of phrases like “picture of…” or “image of…” when describing the image 
unless it is relevant content 

Alt text is read by a screen reader in a Word file; if we add alt text to our Word Document 

before we export it as a PDF, the alt text should remain intact, and add to the accessibility of 

our PDF. 

2.1.5. Long descriptions 

There are times when a description may not be succinct enough to use an alt attribute and a 

description does not appear in the content of the page. This is common for complex images 

such as charts, maps, and graphs. If adding a long description to the content of the page is 

not feasible then it is best to use the longdesc attribute. This attribute can be used in a couple 

of ways: 

• The image can be a link to the long description page. Alt text should also be provided 
for the image. 

• A link can be added to the content of the page next to or below the image. 

2.1.6. Adding Alt Text 

To add alt text to an image in Word: 
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• Right-click on the image and select Format Picture. A dialogue box will appear. 

• Select the Layout & Properties icon and choose Alt Text. 

• Enter appropriate, meaningful alt text in the Description field. Leave the Title field blank. 

 

Figure 3: Adding Alt text 

2.1.7. Columns 

Columns should be created using the Columns function under Layout to create true columns. 

To create columns: 

1. Select the Layout tab on the ribbon. 
2. Select Columns in the Page Setup group. 
3. Choose the number of columns. 

 

Figure 4: Insert columns 

2.1.8. Colour 

The use of colour can be used in conjunction with bold and italics to add contrast. However, 

it should not be used on its own to signify meaning or importance, as this is not accessibility 

friendly. 
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If we choose to use colour in our text, we should use the WebAIM Colour Contrast Checker to 

ensure that the colour contrast is ideal for users with low vision or other vision-related 

disabilities. Contrast is required to be 4.51:1 for normal-sized text, and 3:1 for large text. To 

make it even better, we should aim for a contrast ratio of 7:1 for normal text, and 4.5:1 for 

large text. 

Examples of large text are provided below: 

Below are some examples of colours available in the Rich Content Editor, along with their 
corresponding contrast ratios: 

 

2.1.9. Lists 

When we are providing a list of information, emphasizing a point, or showing a sequence of 
steps, make sure us are using the Bullet List or Numbered List (also called the Ordered list) 
options in Word to create a true numbered or bulleted list. This formatting is read by screen 
readers to signify that the items are part of the same list. 

Here are some examples of lists, showing the differences between hand-typed (incorrect) 
lists, and lists created with the list functions: 

Bullet List [Good Example, Created with the Bullet List Function] 

• Point A 
• Point B 
• Point C 

Bullet List [Bad Example, Hand-Typed Dashes] 

-Point A 

-Point B 

-Point C 

Numbered/Ordered List [Good Example, Created with the Numbered List Function] 

https://webaim.org/resources/contrastchecker/
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1. Step 1 
2. Step 2 
3. Step 3 

Numbered List [Bad Example, Hand-Typed Numbers] 

1. Step 1 

2. Step 2 

3. Step 3 

While the bad examples and the good examples might appear to be similar visually, they are 
read differently by users who are relying on screen readers to review the content. Formatting 
with the Numbered/Ordered List or the Bullet List conveys that the information all belongs to 
the same list and is related. 

To add the list functions to our content: 

1. Select the Home tab on the ribbon in Word. 
2. Choose the Numbered List or Bulleted List option from the Paragraph group. 

 

Figure 5: Numbered list 

2.1.10. Hyperlinks 

Screen readers and other Ats will read hyperlinks out of context, so it's important to 
remember this when we are adding links to our digital document. Word automatically creates 
a hyperlink when a URL is pasted onto a page, which may not make sense to screen reader 
users, so make sure that the link text is unique. To add links to our digital documents, we 
should attach the link to words that describe the link destination instead of pasting the URL 
directly onto the page. 

Here are three examples of links: 

• [Bad Example] Wikipedia, the free online encyclopaedia, is online here: 
https://www.wikipedia.org/ 

• [Bad Example] Need to find information quickly on the web? Click here for the free 
online encyclopaedia, Wikipedia. 

• [Good Example] Wikipedia is a free online encyclopaedia with a searchable tool to 
find open-source information. 

https://www.wikipedia.org/
https://www.wikipedia.org/
https://www.wikipedia.org/
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As we can see, all of these hyperlinks will get us to the right place, but because the third 
example uses descriptive language in the hyperlink, ATs can read it out of context without 
losing its meaning, and it tells the user exactly where the link will go once it is selected.  

Creating descriptive links also benefits general users who are not using screen readers for the 
same reason: they know there the link will take them when they click on it. 

If the hyperlink already exists in our Word Document, we can use the directions below to 
make it descriptive: 

1. Select a hyperlink, rick click, and select Hyperlink or hit Ctrl + k. 
2. Change the text in the Text to Display field to a more meaningful description. 

 
Figure 6: Insert hyperlink 

We must keep in mind that this information pertains to documents that are digital or online. 
URLs and hyperlinks should be displayed in their entirety for printed materials, such as 
handouts in class. 

2.1.11. Tables 

Tables should be used to display and organize data. They should not be used to design a 
layout. Accessible tables need a clear table structure and table headers to guide a screen 
reader user. 

Headers for Tables 

Headers should always be included for columns and rows. These are not the same as headings 
used to organize sections of text, although they serve a similar purpose in being read by a 
screen reader to convey the structural organization of the information contained in the table. 

To add headers to the first row of our Table in Word: 

1. Select Table Tools, then Layout on the ribbon. 
2. Choose Repeat Header Rows in the Data section. 
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Figure 7: Header for table 

Alt Text for Tables 

Sighted users can quickly scan tables to understand their purpose, but many assistive 
technology users navigate with the keyboard. These users need a table caption to describe 
the purpose and content of a table. 

For our educational content, the tables need to have alt text. 

When using Word, we may notice that some tables will be flagged for missing alt text. The 
same way alt text can convey the meaning of an image, the alt text in a table provides users 
of screen readers the same summary information that sighted users get when quickly 
browsing a table. 

To add alt text to a table: 

1. Right-click on the table. 
2. Select Table Properties from the menu. A Table Properties dialogue box will appear. 
3. Under the Alt Text tab, add our description of the table content. Use the guidelines 

discussed in the Alt Text section of this page for best practices on creating alt text. 

2.1.12. Accessibility Checker 

The Accessibility Checker tool finds accessibility issues in our Word Documents. The tool 
generates a report of issues that could make our content difficult for people with disabilities 
to understand. Accessibility Checker also explains why we should fix these issues and how to 
fix them. 

As we remediate our Word documents, we will notice that Errors and Warnings are cleared 
from the report as we fix them, but Tips will remain in the report even after they have been 
remediated. 

The Microsoft Accessibility Checker tool might not catch all of the accessibility problems in 
our document, such as colour contrast issues. We should make sure we are still thoroughly 
checking our document 

To use the Accessibility Checker: 

1. Select File, then Info. 
2. Click Check for Issues, followed by Check Accessibility. 
3. The checker presents accessibility errors, warnings, and tips for making repairs. 
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Select specific issues in the results to see Additional Information at the bottom of the task 
pane, including Why to Fix and How to Fix, which will give us instructions on how to resolve 
the issues identified by the Checker. 

2.1.13. File Names 

It is also important to consider how we name our files before uploading them into our course. 
Using accessible, internet-friendly file names will ensure our students can recognize the files 
that they're downloading, and that the files can be easily read by ATs. 

2.1.14. Saving As a PDF 

To optimize accessibility, we should consider offering our document in two formats: as a 
Word file, and as a PDF file. PDF can be a better option for electronic sharing since the file size 
is relatively small, distracting slide transitions are usually removed, and everyone has access 
to a PDF reader. All of the accessibility features covered thus far will be retained in a PDF file 
if our Word Document is created correctly. 

2.1.15. Other 

Additional best practices to keep in mind: 

• Ensure that the font size is sufficient, at least 12 points. 

• Refrain from using highly decorative or stylized fonts. Stick with a font that is easy 
to read, like Calibri. 

• Remember to check colour contrast. 

• Do not use colour as the only way to convey meaning. 

• Provide a table of contents for long documents. 

• Use simple language. 

2.2. Creating accessible PowerPoint presentations 

One of the most common ways to create presentations is with PowerPoint. When we create 
a presentation for students to view online, there are steps we can take to make our 
PowerPoint file accessible. 

2.2.1. Templates & Themes 

We should create our presentation by choosing a slide theme or template. The Design tab 
contains built-in themes, with colour variants that can be used to change the aesthetic of the 
presentation. Some templates have low colour contrast between the text and the 
background, so be sure to choose a theme with good contrast and simple backgrounds to 
prevent the design from interfering with the readability of the content on the slides.  
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Figure 8: Themes in PowerPoint 

While there are built-in themes, we can also search through templates that are available for 
download. 

To search for an accessible template: 

1. Go to File 
2. Click New 
3. Enter text into the Search field. 

o If we want to find templates that are tagged as "accessible," we add the 
word "accessible" to our search! This doesn't guarantee accessibility, but it 
does increase the likelihood of finding an accessible template. 

If we want, we can also use one of the templates that Microsoft has identified as optimized 
for accessibility. 

2.2.2. Slide Layouts 

The most important part of PowerPoint accessibility is the use of slide layouts. Using slide 
layouts correctly will ensure that the information on the slides will have the correct heading 
structure and reading order. We can change the layout of a slide at any time, but it's usually 
easier to choose our layout when creating a new slide.  

Most slide layouts will include a slide title at the top of the slide. Similar to headings in Word 
Documents, slide titles identify the content of the slide before a user drill down into the 
content. If each slide has a unique, descriptive title (i.e., it is not repeated across multiple 
slides, or it's not vague), this will make it much easier for screen reader users to read and 
navigate the presentation. 

Slide layouts will also typically contain at least one placeholder area for us stead of inserting 
content onto a blank slide. 

2.2.3. Create a New Slide 

1. Click on the Home or Insert tab. 
2. From there we can either: 

o Click on the New Slide icon, which will create a new slide with the same 
layout as the slide we currently have selected OR 

https://templates.office.com/en-us/Accessible-Template-Sampler-TM16401472?ui=en-US&rs=en-US&ad=US
https://templates.office.com/en-us/Accessible-Template-Sampler-TM16401472?ui=en-US&rs=en-US&ad=US
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o Click the small arrow or "New Slide" text to display a drop-down menu with 
all of the available slide layouts. 

3. Select one of the slides layout options to create a new slide with that selected 
layout. 

 

Figure 9: New slide 

2.2.4. Change an Existing Slide Layout 

1. Click on the slide we would like to change.  
2. Go to the Home tab. 
3. Select Layout. 
4. Choose our preferred layout from the dropdown. 

If we apply a layout to a slide that wasn't structured correctly (e.g., using Insert Pictures 
and/or Insert Text Box onto a blank slide instead of using content placeholders), we might 
have to put in some work cutting, pasting, and deleting unnecessary boxes to apply the 
correct layout. 

2.2.5. Slide Master 

Using the Slide Master view, we can: 

• make adjustments to the design (like changing the text size of slide titles) so they 
apply to all slides within a presentation 

• make changes to a specific slide layout 

• create new and/or custom layouts 

To open the Slide Master: 

1. Select the View tab along the top 
2. Click Slide Master 
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Layout options are displayed to the left. The first slide is the Master Layout, followed by 
different individual layouts. Changes made to any of these will be applied to slides using the 
corresponding layouts.  

2.2.6. Slide Reading Order 

If it is impractical to use a slide layout to add content to a slide, we can still add the content if 
we check the slide reading order. Reading order refers to the order in which a screen reader 
will dictate the slide contents to a user. By default, a screen reader will read the slide title 
first, followed by other content in elements defined by the slide layout. Any additional 
content on the slide will then be read in the order in which it was added to the slide. 

 
Figure 10: Slide reading order 

To Check the Reading Order 

1. Clicking Home from the tab along the top 
2. Select Arrange. 
3. Choose Selection Pane. The Selection Pane will appear on the right as a sidebar. 

This pane will show a list of every object on the slide. If we select an object on the pane to 
highlight it, we will also see it highlighted on the slide. 

The reading order for the elements in this page goes from the bottom to the top. Think of the 
items as layers; if we start on the base layer (blank slide), we are at the bottom. To view each 
layer, we would move up through the items. 

To reorder an item, simply click and drag it within the list. We can also use the up/down 
arrows. 

2.2.7. Accessibility Checker 

Like other Microsoft Office products, PowerPoint includes a tool that will identify and assist 
us in fixing common accessibility issues. When we run the Accessibility Checker tool in 
PowerPoint, it will generate a report of issues that could make our content difficult for people 
with disabilities to understand along with an explanation of why we should fix these issues 
and instructions on how to fix them. 
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To Run the Accessibility Checker Tool 

1. In our PowerPoint file, select File. 
2. Click Info. 
3. Select the Check for Issues button. 
4. Choose Check Accessibility from the drop-down menu that appears. 
5. The Accessibility Checker will open on the right of our PowerPoint slide as a 

sidebar.  
6. Select each item in the report to highlight the issue within the slide. Information 

about the issue, and instructions on how to repair it, will appear at the bottom of 
the sidebar when we select an issue. 

 

Figure 11: Check accesibility 

Once an issue is resolved, it will disappear from the report. Make sure to run the Accessibility 
Checker one last time to check for any remaining issues before saving our file. 

2.2.8. Other 

Additional best practices to keep in mind: 

• Avoid using orange, red, and green in our text and backgrounds. Instead, use 
colours that provide maximum contrast.  

• Make sure text is not too small. 

• Avoid adding text on top of busy backgrounds. 

• Be considerate in our use of fonts; avoid fonts that are over-stylized and opt for 
fonts that are easy to read. 

• Do not use colour as the only way to convey information. 
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• Transitions and animations should be simple. 

• Complex or automatic transitions and animations can be distracting. 

• Use clear and simple language. 

• If we have embedded video, ensure the video is captioned. 

• If we have embedded audio, include a transcript. 
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3. Annex 3: Accessibility Assessment Tools 

Authoring 

• How to make common word processing documents more accessible 
• An example of a Mozilla browser plugin for removing clutter 

Checking code 

• Calculate the readability of a web page 
• W3C tool for validating mark-up by URI 
• W3C tool for validating CSS by URI 
• Evaluate the accessibility of web pages or HTML 

Checking colour 

• http://colourfilter.wickline.org 
• http://vischeck.com 
• http://gmazzocato.altervista.org/colourwheel/wheel.php 
• http://www.snook.ca/technical/colour_contrast/colour.html 
• http://webaim.org/resources/contrastchecker/ 

Standards 

The World Wide Web Consortium (W3C) develops web-related standards, the best known of 
which is probably HTML. The W3C process attempts to ensure accessibility is considered in all 
of its standards; in addition, several accessibility-focused standards have been produced. 
These are: 

• Accessible Rich Internet Applications (ARIA): defines a technology for making dynamic 
web applications more accessible. 

• Web Content Accessibility Guidelines (WCAG): guidelines for creating accessible 
websites. 

• Authoring Tool Accessibility (ATAG): guidelines for developing authoring tools that 
encourage and support authors to create accessible websites. 

• User Agent Accessibility Guidelines (UAAG): guidelines for developers of browsers, 
media players, etc. that facilitate accessible use. 

  

http://adod.idrc.ocad.ca/
https://www.readability.com/addons
http://www.read-able.com/
http://validator.w3.org/
http://jigsaw.w3.org/css-validator/
http://achecker.ca/
http://colorfilter.wickline.org/
http://vischeck.com/
http://gmazzocato.altervista.org/colorwheel/wheel.php
http://www.snook.ca/technical/colour_contrast/colour.html
http://webaim.org/resources/contrastchecker/
http://www.w3.org/WAI/intro/aria
http://www.w3.org/TR/WCAG20/
http://www.w3.org/TR/WAI-AUTOOLS/
http://www.w3.org/WAI/intro/uaag.php
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4. Annex 4: How to use the European Easy-to-Read Logo  

 
Figure 12: Easy-to-Read Logo 

Inclusion Europe has developed the European easy-to-read logo and holds its copyright. We 
allow, however, the free use of the logo, if the following basic conditions are met: 

• People using the logo must follow the “Guidelines for easy-to-read publications”. 
• The use of this logo must be done following these indications: 

a. Colour: Blue: 

PANTONE – 072;  

CMYK – Cyan 100%, Magenta 87%, Black 6%; 

RVB: 26-63-147; 

WEB: #333399  

b. Minimum size: 15mm 

• One or several persons with intellectual disability whose native language is the 
language you are using in your publication should proofread your publication. The 
name of the proof-readers should appear in the brochure. 

• You must mention the following sentence in your publications: “© European Easy-to-
Read Logo: Inclusion Europe. More information at https://www.inclusion-
europe.eu/easy-to-read/”. 

• If there is an electronic version made available for download, you must provide us 
with the relevant URL at comms@inclusion-europe.org. 

• Inclusion Europe reserves the right to withdraw the permission to use the European 
Easy-to-Read Logo if the submitted publications should raise serious doubts that the 
easy-to-read rules were followed in their preparation. 

  

https://www.inclusion-europe.eu/easy-to-read/
https://www.inclusion-europe.eu/easy-to-read/
mailto:comms@inclusion-europe.org
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5. Annex 5: Easy-to-read checklist to make sure your document is easy 

to read  

5.1.1. How the document looks like   

Numbers  

 Are the pages numbered?  
o The front cover does not need a number, but all the other pages should be 

numbered.  

o The number should be on the bottom right of each page.  

Writing  

 Is the writing Arial, size 14 or bigger?  

Alignment  

 Is the text aligned left?  

Images  

 Are there images next to the text to help people understand what the text is about?  
 Are the images easy to understand?  

Titles  

 Are the titles clear and easy to understand?  
 Are the titles bold?  

5.1.2. The sentences and words  

Sentences  

 Does each new sentence start on a new line?  
 Are the sentences 1 or 2 lines long?  
 Are most of the sentences positive?  

Words  

 Are the words simple?  
 Are the difficult words explained more than once?  

o Difficult words should be explained every time they are used.  

 Are some words split into two lines?  
o It is not good to split a word into two lines.  

 Are numbers written as digits?  
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o It is good to write numbers as digits not words.  

5.1.3. How the information is ordered  

 Is the main information easy to find?  
 Is the information in order and easy to follow?  

o For example, if one thing happens after the other, it should be written like this 
in the text.  

o For example, Susi ate pizza. Then she went to play football.  

 Is each paragraph about one topic? 
 Are examples used to explain things?  
 Are bullet points used for lists?  

o It is better to use bullet points than commas.  

 When the text says he or she, is it clear whom it is talking about? 


